
Abstract
Thousand-grain weight (TGW) is one of the major yield-contributing traits routinely used as a selection criterion by plant breeders. It 
is also an important grain quality trait that determines milling yield. Accurate phenotyping of TGW is imperative to dissect its genetics 
for yield improvement. The traditional approach to TGW estimation involves manual grain counting and weighing, which is laborious, 
tedious and less accurate for large sample sizes. As an alternative, we propose a customized grain counting setup for accurate estimation 
of TGW in wheat by assembling a photo lighting tent and a smartphone for image acquisition of grain samples. A popular open-source 
software, ‘imageJ’ was used to process the images to estimate the grain count. The counted grain samples were weighed to calculate 
the TGW. The TGW estimate derived from the proposed grain counting setup displayed a high degree of correlation with the manually 
estimated TGW data (r = 0.99, p <0.05). It took significantly less time to count the grain samples using the proposed setup compared 
to manual counting with better accuracy and minimal labor. The error rate in grain counting using the imaging-based setup was very 
low (<1%) and 30 to 40 grain samples can be imaged per hour. This setup can be extended to estimate the TGW of different crops, 
excluding those having spherical seeds.
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Introduction
Wheat is an important cereal crop consumed across the 
globe and its demand is increasing day by day (Shewry 
and Hey 2015). To keep pace with the expanding global 
population, food production need to increase by 50% before 
2050 (FAO 2017). Thousand-grain weight (TGW) is one of the 
principal components affecting grain yield, the rest being 
grain number per ear and productive tillers per unit area 
(Surek and Beser 2003; Yousaf et al. 2017; Ullah et al. 2021; 
Farokhzadeh et al. 2023). Thousand-grain weight is reported 
to be positively correlated with grain size, grain length, 
grain width, grain area and grain yield (Dholakia et al. 2003; 
Abdipour et al. 2016; Sefaoglu 2023). Seeds with higher TGW 
tend to have better vigor and germination rates (Ambika 
et al. 2014). Larger grains provide more nutrients to the 
developing embryos and help in proper root development 
and seedling establishment (Zohaib et al. 2018; Muhsin et 
al. 2021). Plump and bold grains are preferred by grain mills 
and consumers of certain geographies (Ponce-Garcia et al. 
2017; Custodio et al. 2019). Being a quantitative trait, TGW 
is controlled by multiple genes and warrants the use of 
quantitative trait loci (QTL) analysis to identify the genomic 
regions controlling it (Sun et al. 2009; Li et al. 2015; Jha et al. 

2022). Accurate phenotyping of TGW is crucial for capturing 
the phenotypic variation in the mapping populations with 
the minimum error to aid in QTL discovery. The traditional 
phenotyping method involves manual counting of 50 to 
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300 grains, weighing and calculating TGW (Su et al. 2011; 
Zhang et al. 2013). The traditional method is laborious, 
time-consuming and less accurate for large sample sizes. 
Its efficiency varies based on the skill level of the worker, 
the number of grain samples and grain sample size. As 
an alternative, image acquisition and processing can be 
deployed to improve the accuracy and speed of grain 
counting (Paige et al. 1991; Sabanci et al. 2016). 

A number of software and instruments have been 
developed for grain counting and thousand-grain weight 
estimation. ‘GainTKW’, an android-based mobile application 
was developed for the estimation of grain weight by 
integrating grain weighing and counting (Wu et al. 2018). 
Similar mobile application-based grain counting methods 
have been developed recently that can distinguish closely 
spaced grains as well (Komyshev et al. 2017; Liu et al. 2017; 
Gao et al. 2017). Sabanci et al. (2016) used Matlab software 
to process the images of the wheat grain samples spread 
on a dark background for grain counting, followed by 
grain weight estimation. An image analysis-based protocol 
for grain counting in maize was devised by Makanza et 
al. (2018) that involves processing photographed grain 
images using open-source software imageJ. Singh et 
al. (2019) implemented a machine-learning model on 
processed images to predict the size and mass of rice grains. 
A Python-based software package with a graphical user 
interface, ‘Gridfree’ was developed by Huand Zhang (2021) 
that uses an unsupervised machine learning approach, 
K-means, to measure grain count, area, length and width. 
Instruments and machines are available on the market for 
estimating grain count and weight but are expensive, time-
consuming and specific to certain classes of seeds. There 
is a need to develop a technology-driven, rapid, low-cost 
and user-friendly methodology for precision phenotyping 
of thousand grain weight. To cater to this need, we propose 
an ingenious grain counting setup for estimating the 
thousand-grain weight of wheat based on imaging and 
image processing. 

Materials and methods

Seed materials and manual grain counting
The grains of the ten wheat varieties released at the state/
national level were used to test the efficiency of the grain 
counting setup. The ten wheat varieties included six bread 
wheat cultivars (HD2967, HD3086, DBW17, WH1105, PBW723 
and PBW725) and four durum wheat cultivars (PBW114, 
PDW233, PDW274 and PDW291). Each variety was replicated 
thrice, and ten grams of grain were sampled per replicate. In 
the case of manual grain counting, the seeds were counted 
by spreading them in small trays with dimensions of 22 cm  
by 27 cm by 6 cm (Length, Width, Height).  The grain count 
data was recorded.

Grain counting setup
A photo lighting light tent with dimensions of 40 x 40 x 
40 cm was purchased from Amazon for about INR 4000 
($50) (Brand: House of Quirk). The tent comprises a cubical 
box with two LED panels for uniform illumination. The 
LED panels are provided with plugs for connecting to an 
external power source. A circular hole is provided on the 
top face of the cubical box for image capture from the top 
view, and the front face can be opened for image capture 
from the side view. The stage of the light tent was pasted 
with a white-colored plastic sheet for spreading the grain 
samples. A picture of the photo lighting light tent is given 
in Supplementary Fig. 1.

Image capturing 
Ten grams of grain samples were spread widely and imaged 
so that each grain was selected as a distinct entity by the 
image analysis software. Photos of the spread grains were 
captured from the top angle at a fixed height using a Lenovo 
K8 Plus smartphone (13-megapixel camera). For each 
genotype, cardboard labels were placed near the borders 
of the stage for identification. The image dimensions were 
4160 x 3120 pixels. Two people were involved in the imaging 
process, one for spreading the grain samples and the other 
for capturing images. After imaging all the varieties, the 
captured images were transferred to a laptop for further 
image processing. The methodology involved in image 
capture is schematically explained in Fig. 1. 

Image analysis
The grain images were processed using the open-source 
software ImageJ (Schneider et al. 2012) (Supplementary Fig. 
2). The image file was opened by clicking the ‘Open’ option 
from the ‘File’ menu. The opened image is first converted to 
8-bit grayscale image by clicking the ‘Image’ menu followed 
by ‘Type’ and selecting ‘8-bit’. The image thresholding was 
done by choosing the ‘Image’ menu, followed by the ‘Adjust’ 
option, followed by the ‘Threshold’ option. This step converts 
the grayscale image into a binary image and the background 
contrast can be adjusted if needed. Alternatively, a binary 
image can also be generated by selecting the ‘Process’ menu 
followed by the ‘Binary’ option and selecting ‘Make Binary’. 
The area containing the spread grains is selected from the 
binary image using the rectangular selection tool from the 
toolbar. The selected region is subjected to grain counting 
by clicking the ‘Analyze’ menu and choosing the ‘Analyze 

Fig. 1.  Schematic  outline  of the steps involved in grain image 
capturing
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Particles’ option. A new dialog box opens, containing various 
parameters and options. In the ‘Size’ parameter, the value 
(in square pixels) was fixed as 200-infinity. This refers to the 
grain area cut-off value above which most of the wheat 
grains fall. Objects having a size of less than 200 square 
pixels are excluded from counting, and these can be broken 
grains, dust particles, husk, etc. This cutoff value can be fixed 
by observing the individual grain areas of unbroken grains 
calculated from different wheat varieties. In the ‘Show’ 
drop-down box, the ‘Outlines’ option is selected, which 
numbers all the individual grains from the selected region. 
The other parameters are set as default. The ‘Summarize’ 
box is checked and the rest of the boxes are left unchecked. 
A new ‘Results’ dialog box opens, displaying the average 
grain area of the processed sample along with the grain 
count data in tabular format. The ‘Display results’ box can be 
checked to tabulate the grain area of each grain belonging 
to the selected region (Supplementary Fig. 3). This table 
can be used to fix the minimum grain size cut-off value. 
The above steps can be repeated for each image, and the 
grain count data gets added one below the other in the 
‘Summary’ table. These results can be directly copied and 
pasted into Microsoft Excel. A brief flowchart describing the 
image processing steps is given in Fig. 2.

Thousand-grain weight estimation
All the grains counted through image analysis or manually 
were weighed on the weighing balance (model: Citizen 
CY220, Aczet Private Limited, Mumbai). The thousand-grain 
weight (TGW) was calculated using the following formula 
in MS Excel,

TGW = [Grain weight (in grams)/Grain count] x 1000

Grain count error rate calculation
The grain count error rate was used to predict the grain 
counting accuracy of the proposed imaging-based method. 
The error rate observed in grain counting by the imaging-
based method in relation to the manual labor-based method 
(ground truth) is calculated using the following formula in 
MS Excel,

Table 1. Comparison of the mean grain count and thousand grain 
weight values of different varieties estimated by imaging-based and 
manual labour-based methods

Variety Method Grain count Grain 
count Error 
rate (%)

TGW (g)

HD2967
Imaging-based 294.7 ± 7.6a

0.20
33.9 ± 0.9 a

Manual labour 295.3 ± 8.5 a 33.9 ± 1.0 a

HD3086
Imaging-based 319.0 ± 5.0 a

0.85
31.3 ± 0.5 a

Manual labour 316.3 ± 6.1 a 31.6 ± 0.6 a

DBW17
Imaging-based 309.0 ± 5.2 a

0.42
32.4 ± 0.5 a

Manual labour 307.7 ± 6.4 a 32.5 ± 0.7 a

WH1105
Imaging-based 270.0 ± 9.5 a

0.48
37.1 ± 1.3 a

Manual labour 268.7 ± 10.5 a 37.2 ± 1.5 a

PBW723
Imaging-based 233.0 ± 3.6 a

0.43
42.9 ± 0.7 a

Manual labour 232.0 ± 4.3 a 43.1 ± 0.8 a

PBW725
Imaging-based 248.7 ± 6.4 a

0.16
40.2 ± 1.0 a

Manual labour 248.3 ± 5.8 a 40.3 ± 0.9 a

PBW114
Imaging-based 253.3 ± 7.8 a

0.00
39.5 ± 1.2 a 

Manual labour 253.3 ± 5.0 a 39.5 ± 0.8 a

PDW233
Imaging-based 231.7 ± 6.4 a

0.61
43.2 ± 1.2 a

Manual labour 230.3 ± 7.6 a 43.4 ± 1.4 a

PDW274
Imaging-based 289.0 ± 10.5 a

1.15
34.6 ± 1.2 a

Manual labour 285.7 ± 13.4 a 35.0 ± 1.6 a

PDW291
Imaging-based 256.7 ± 3.5 a

0.27
39.0 ± 0.5 a

Manual labour 256.0 ± 2.6 a 39.0 ± 0.4 a

*Grain count and TGW values are represented as Mean ± Standard 
deviation
*Mean values labelled with different superscripts are significantly 
different at p-value<0.05 for Grain count and TGW

Fig. 2. Flow chart depicting the image processing methodology for 
estimating grain count using imageJ software

Error rate (%) = [(N-N0)/N] x 100 
where, N0= mean grain count data of a variety calculated by 
the imaging-based method
N = mean grain count data of same variety obtained from 
manual counting

Statistical data analysis
The mean TGW and standard deviation values for each 
variety were calculated in MS Excel. The summary statistics 
and t-test of the TGW estimates were computed using 
PAST 4.03 software (Hammer et al. 2001). The correlation 
scatterplots and the box plots were computed using the 
‘ggplot2’ package in R software (R Core Team 2013; Wickham 
2016). 

Results

Grain counting
The mean grain count data of the selected varieties is 
presented in Table 1. The estimates from both imaging-
based and manual labor-based methods were nearly similar, 
and a t-test revealed the mean differences to be statistically 
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non-significant. The summary statistics of the grain count 
data also revealed a similar picture (Table 2). From Table 2, 
it was observed that the mean grain count data calculated 
using the imaging-based method (270.5) was slightly higher 
than the manual labor-based method (269.4). The minimum 
and maximum values of the grain count estimated by the 
imaging-based method were slightly higher compared to 
the manual method. The lowest grain count was recorded 
for the durum wheat variety PDW233 (231.7 and 230.3), 
whereas the bread wheat variety HD3086 recorded the 
highest grain count (319.0 and 316.3) under both methods 
(Table 1). The error rates observed in grain counting by 
the imaging-based method in regard to manual counting 
were very low, ranging from 0 to 1.15% among the selected 
varieties (Table 1). This indicates that the imaging-based 
method has high accuracy. The distributions of grain count 
data obtained from imaging-based and manual labor-based 
methods are displayed in the form of box plots with grain 
count values jittered on them (Fig. 3A). Both the distributions 
had similar patterns without much deviation, indicating the 

accuracy of the imaging-based method with the ground 
truth values. Moreover, it took, on average, five minutes to 
count a single grain sample of 10 grams using manual labor. 
On the contrary, it took just around two minutes to spread 
and image the grain sample using the newly proposed 
imaging setup and an additional one minute to process the 
image for grain count estimation.

Thousand-grain weight estimation
The mean TGW values of the varieties are listed in Table 1, 
which indicates a high degree of correlation among the TGW 
estimates derived from imaging-based and manual labor-
based approaches. This was further validated by a t-test that 
revealed the mean differences of TGW values calculated 
using both methods to be statistically non-significant. The 
durum wheat cultivar PDW233 recorded the highest TGW 
under both estimation methods (43.2 and 43.4 grams) owing 
to its lowest grain count among the selected varieties. This 
was obvious, as large-sized grains contributed to higher 
grain weight. Similarly, the variety with the highest grain 
count, cv. HD3086, recorded the lowest TGW (31.3 and 
31.6 grams) under both methods. The distributions of the 
TGW values estimated from both methods were nearly 
identical, and the median TGW value of the manual labor-
based method was slightly greater than the imaging-based 
method (Fig. 3B). 

Correlation between TGW estimates of imaging-
based and manual labor-based methods
The scatterplot depicting the extent of correlation between 

Table 2. Comparison of the summary statistics of the replicated data for thousand grain weight and grain count estimates obtained from 
imaging-based and manual labour-based methods

Statistics Grain count (Imaging-based) Grain count (Manual labour) TGW (g) (Imaging-based) TGW (g) (Manual labour)

Minimum 227 225 31.0 30.9

Maximum 324 323 44.4 44.0

Mean 270.5 269.4 37.6 37.4

Standard deviation 30.4 30.2 4.1 4.1

a

b

Fig. 3. Distribution of grain count (A) and thousand grain weight (B) 
values estimated by imaging-based and manual labour-based methods 
displayed in the form of boxplots overlaid with jitters

Fig. 4. Scatterplot depicting the degree of correlation between the 
thousand grain estimates derived from imaging-based and manual 
grain counting methods
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the replicated TGW estimates of imaging-based and manual 
labor-based approaches is given in Fig. 4. It is clearly evident 
that there is a high degree of correlation between the TGW 
estimates derived from the two methods (r=0.99; strong, 
positive correlation), as most of the data points fall on the 
trend line (line of best fit) or are located very close to the 
trend line. 

Discussion
Thousand-grain weight (TGW) is one of the key traits 
contributing to grain yield, and an accurate estimation of 
TGW is crucial for carrying out selections in a breeding 
population and for conducting QTL mapping studies. The 
traditional approach to TGW estimation involves manual 
counting of a representative number of grains followed 
by weighing to calculate TGW. This method is tedious 
and laborious and its accuracy varies depending on the 
skill level of the worker and the sample size. Automated 
seed counting machines are available on the market, but 
are expensive and specific to certain categories of seeds. 
To overcome these limitations, image-processing-based 
methods have been developed in the recent past based 
on the Android operating system (Liu et al. 2017; Gao et al. 
2017; Wu et al. 2018) and desktop PCs (Sabanci et al. 2016; 
Hu and Zhang 2021). In the present study, we developed an 
imaging-based grain counting setup for wheat that involves 
a photo lighting tent and a smartphone for grain imaging, 
followed by image analysis using imageJ software on a 
laptop or PC. The grains were spread manually on a white 
background ensuring that the individual grains do not touch 
each other. This step significantly reduces the error rate in 
grain count estimates, resulting in improved accuracy. The 
error rate in our grain count estimates was well below one 
percent in most of the grain samples (Table 1). It took on 
average 3 minutes to process a grain sample image using 
our method in comparison to other software (Gao et al. 
2017; Liu et al. 2017; Wu et al. 2018) which consumed less 
than a minute. This limitation of our setup was offset by 
increased grain counting accuracy. Some of the reported 
software used different image segmentation methods 
to count grain samples that were not spread manually 
(containing a large number of touching grains) and that 
resulted in high error rates when sample sizes increased 
(Gao et al. 2017; Wu et al. 2018; Hu and Zhang 2021). We 
successfully demonstrated the counting of grain samples 
of selected wheat varieties with an average sample size of 
270 grains, which is a good representation of the thousand-
grain count. Background illumination is a major factor 
affecting the quality of smartphone-captured images, as 
demonstrated by the studies of McCracken and Yoon (2016) 
and Komyshev et al. (2017). In the current study, two LED 
strips were assembled inside the photo lighting tent that 
provided uniform illumination and resulted in high-quality 
shadow-free images (Supplementary Fig. 4). Looking at Table 

1, we could find that the mean grain count values of the 
two varieties, HD3086 and PDW274, determined by manual 
counting were lower than the imaging-based estimates by 
2 to 3 units. This may be due to human error during the 
manual counting of grains, as the imageJ software does 
not miss out on the selected grains. The ‘size’ option in 
the ‘Analyze particles’ function helps to exclude dust, dirt 
and broken kernels during the grain counting process. This 
helps to increase the precision of the grain count estimate. 
Using the proposed grain counting setup, we were able 
to process 30 to 40 samples per hour, depending on the 
competence of the workers. In contrast, the grain counting 
rate of manual counting was merely 12 to 15 samples per 
hour, which denotes the superiority of the proposed setup. 

The grain counting setup can be extended to count 
grains of other crops having non-spherical seeds, including 
rice, maize, oats, barley, cotton, groundnut, soybean, gourds, 
pulses, etc. The setup is portable and can be folded and 
carried easily (Supplementary Fig. 1). It works decently with 
entry-level smartphones or cameras having a pixel quality of 
12 megapixels or above. Photo lighting tents manufactured 
by various companies or brands can be used for assembling 
the grain counting setup. By replicating the imaging setup 
and manpower, the rate of grain samples processed per day 
can be doubled. 

To summarize, we have proposed a cost-effective novel 
imaging-based grain counting setup for estimating the 
thousand-grain weight of wheat and other crops that is 
quick, cost-effective, less laborious and accurate. We tested 
the efficiency of the grain counting setup using ten different 
wheat varieties and compared the results to the ground-
truth (manual labor-based grain counting and weighing) 
experiments. The thousand-grain weight data estimated 
using the imaging setup was highly correlated with the 
TGW estimates obtained from the manual labor-based 
method and, at the same time, is relatively less tedious and 
more precise. After validation on 10 wheat genotypes, the 
proposed setup was used for phenotyping a set of more 
than 300 advanced backcross introgression lines, and the 
data was used for QTL mapping for TGW, which is being 
reported in a separate manuscript. 

Supplementary materials
Supplementary Figs. 1-4 are provided online, www.isgpb.org
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Supplementary Fig. 3. Results table displaying the grain areas of the numbered grains from aprocessedgra in sample image

Supplementary Fig. 1. Photo lightingtent used for grain imaging: (a) ‘House of Quirk’ Photo lighting tent, (b) LED light panels for illumination 
and (c) Packed photo lighting tent is retrieved from: https://www.amazon.in/House-Quirk-Portable-PhotographyBackdrops/dp/B08LCBB45J)

Supplementary Fig. 2. A screenshot of the ImageJ software version 1.52a

(i)

https://www.amazon.in/House-Quirk-Portable-PhotographyBackdrops/dp/B08LCBB45J
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Supplementary Fig. 4. Wheat grain sample image captured using the smartphone Lenovo K8 plus

(ii)


